
Designer Envelopes Help Topics
Click on Toolbar Button for information:

Menu Topics:
File Menu Opening, saving and printing layout files.
Layout Menu Design and edit layout files.
Tools Menu Use Windows programs to aid in your designs.
Options Menu Setting up the system options.
Help Menu Help on using the system.
Other Topics:

Default Font Setting the default text font.
Editing Objects Editing existing objects.
Layout Grid Why objects "snap" into place.
Moving Objects Moving objects around on the layout.
Print Resolution Difference between 150 and 300 DPI.
Sizing Grid Auto-scaling to fit envelope sizes.



File Menu
The file menu allows you to open, save and print files.    It also allows you to exit the system.    
Menu options are as follows:

New
Open
Save
Save As
Print
Print Setup
Print Special
Quit



File New
Use this option to open an empty (new) layout file. The new file will be entitled TEMP.ENV 
until you use the File SaveAs option to save it.When you save your file, you may name it 
however you like, such as WORK.ENV or BUSINESS.ENV or HOME_ADD.ENV.

See Also
File Open
File Save As
Moving Objects



File Open
This feature allows you to open your saved layout files.    All objects (text, pictures, etc.) will be 
drawn on your screen.    Once the objects are drawn, you may change, add or delete any of the 
objects in this file.    NOTE:    If you make any changes to the file, you will be prompted to save 
the changes.    If you choose not to save the changes, they will not be added to the file.    

See Also

File Save As
Letterhead Stationery



File Save
This option will save any changes made to the layout to the current    open file. You may save the 
changes to another file by using the File Save As menu option.    Any changes you make to the 
current layout are not saved into the file until you select one of the save options.    If you try to 
exit a file without saving it, you will be prompted to do so. 

See Also

File Open
File Save As



File Save As
This option allows you to save the current layout file to another file name.    This enables you to 
copy the existing file objects into another file.    You can also use this feature after you have 
opened up a new file. When you are satisfied with your new layout, use the Save As option to 
save your work to a file.

See Also

File Open
File Save
Letterhead Stationery



File Print 
This option allows you to print the current layout on your printer. The    current layout size is 
used.    When printing envelopes, you should use the Print Setup to make sure your printer is set 
to landscape mode. See the topic below for more information.    You can select this option from 
the file menu or by selecting the printer picture button (shown above) on the tool button bar.
See Also
File Print Setup
File Print Special
Layout Selection
Letterhead Stationery



File Print Setup
Using this option allows you to select a printer, setup your page orientation and select the method
your printer uses to print envelopes. This program will print envelopes on any printer that has the
capacity to print them.    Generally, if the top edge of your envelope is feed into your printer, you 
must be in portrait mode with TOP tray selected. If the right edge of your envelope is feed into 
your printer first, landscape mode should be selected and the tray setting depends on where you 
feed your envelopes.    If you are creating letterhead Stationery, you should be in portrait mode.    
See the Common Asked Questions otption on the Help Menu for more on this if you have 
trouble.

On the bottom of the print setup box is the envelope tray output selections, top, center or bottom. 
Select one of these to tell the program where your envelopes are feed into your printer.    Okidata 
printers generally feed envelopes into the center of the paper tray while HP's generally use the 
top edge of the paper tray.    You can consult your printers manual or try the different settings 
until you find the one that works for you.

IMPORTANT:    DO NOT FEED A CLASP ENVELOPE INTO YOUR PRINTER! YOU WILL 
CAUSE SERIOUS DAMAGE TO YOUR PRINTER.    When shopping for your envelopes, 
make sure to buy envelopes which do not contain a clasp.    We know of people who remove the 
clasps with a staple remover before printing their envelopes.    You can use this method if you 
can't find envelopes without a clasp, but under no circumstances should you feed an envelope 
with the clasp attached.

When you send your layout to the printer, the Windows Print Manager will take control. This 
could cause Designer Envelopes to "slow down" until the layout has finished printing.    To avoid
this, open the Windows Print Manager and pull down the OPTIONS menu.    Select the Medium 
Priority option.    This will return control back to Designer Envelopes much quicker when 
sending layouts to your printer and will allow you to work while your design prints in the 
background.

See Also

File Print
File Print Special
Letterhead Stationery



File Print Special
This feature allows you to define special margin settings that are used when you print your 
layouts.    When you use the print setup menu option you select one of three envelope print 
options, top, center or bottom. If for some reason, your layout is not printing correctly on the 
envelope, you can use this feature to adjust the top and right margins of the printer.    

You can adjust the top and/or left margins by entering numbers into the two displayed fields.    
These numbers do NOT become the margins, rather, they are added to the current (internal) 
margins.    This gives you the ability to adjust the internal margins to reflect your printer. The 
numbers you enter represent one character LETTER (column) spacing for the left margin and 
one character LINE (row) spacing for the top margin.    Select a positive number to increase the 
margins or enter negative numbers to decrease margins.

For example, suppose your printer prints envelopes in the center of your printer paper tray 
(Okidata laser printers do), and suppose you select the center option on the print setup.    You 
then print your envelope and see that the top line of your return address has been cut off.    This 
means that the internal (within the program) margin is set one line too low for your printer.    You
need to increase the top margin by one line. To do this, enter a number one (1) in the top margin 
box.    This tells the program to add one line from it's internal margin setting. Likewise, if you 
needed to reduce the top margin you would need to enter a negative number one (-1), which 
would reduce the top margin by one line. You can experiment with these settings until you find 
what works best for your printer.    Using this feature will allow you to print on any printer.    

See Also

File Print Setup
File Print



File Exit
Use this option to close down your files and exit the program.    You can also double-click your 
mouse on the control box in the upper left hand corner of the main screen.



Layout Menu
The layout menu provides you with options to create your layout designs. The available options 
are:

Size Selection
Text
Picture
Line
Rectangle
Refresh
Clear Contents
Change All Fonts



Size Selection
Use this menu option to select the size of the paper you will be printing your layout on.    This 
allows you to print your layout on various size envelopes.    Depending on which size you have 
selected, the program will "scale" the printed output so that it looks nice when it prints out. It    is 
done in a fashion that attempts to "fill" the envelope with your design to create a professional 
appearance.    Size selection has no effect on letterhead layouts because they are always 8 1/2 by 
11 or legal size paper.

We designed this feature because we did not feel that you should create a layout for each size of 
envelope you use.    Instead, we opted to make the program scale your layout to fit on any 
selected envelope size. A major advantage of this would be, for example, if you only had one 
layout created and you wanted this layout to be used for all of your customers. If you needed to 
send out flyers, you could use the 4 1/8 inch by 9 1/2 inch envelope (a standard envelope size).    
If you needed to send out manuals that require a 6 inch by 9 inch envelope, you could simply 
select that envelope size and still use the same layout you already were using. This allows you to 
create a single layout and use it with all of your envelopes.

The Sizing Grid shows you what portions of your layout will be scaled. You should review the 
Sizing Grid topic for a better understanding.

See Also

Layout Grid
Letterhead Stationery
Sizing Grid



Text Objects 
Use this option to add Text Objects to your layouts.    You can select this feature by using the 
layout menu or by selecting the picture button (shown above) from the tool button bar.    NOTE:   
A new Text Object is always placed using the current default font.    
When you select this option, the cursor will turn into a cross.    Move the cross to the area of your
layout that you want to place the text on, then click the left mouse button to place the Text 
Object.    Next, double-click on the Text Object to change it's attributes.    You can change the 
text, font or remove the object from the layout.    You can also move text to a different location 
by "dragging" it around your layout.    See "moving objects" for more information on this.    Note:
As with all objects, the Text Objects will "snap" into place on the layout grid.    Please read the 
layout grid topic for more information.
See Also

Default Font 
Editing Objects
Layout Grid
Moving Objects



Picture Objects 
Use this option to add Picture Objects to your layouts.    You can select this feature by using the 
layout menu or by selecting the picture button (shown above) from the tool button bar.
When you select this option, first you are prompted to select a picture file. After selecting a 
picture the cursor will turn into a cross.    Move the cross to the area of your layout that you want 
to place the picture on, then click the left mouse button to place the Picture Object.    If you want 
to edit the picture, you can double-click on the image. You can also move pictures to a different 
location by "dragging" it around your layout.    See "moving objects" for more information on 
this.    Note:    As with all objects, the Picture Objects will "snap" into place on the layout grid.    
Please read the layout grid topic for more information.
See Also

Editing Objects
Moving Objects
Layout Grid



Line Objects 
Use this option to add Line Objects to your layouts.    You can select this feature by using the 
layout menu or by selecting the picture button (shown above) from the tool button bar.    Note: 
All lines may only be drawn straight (up/down or left/right).    Also, lines are scaled so that they 
look the same on small and large envelopes.    If you want to draw a box around objects, use the 
rectangle option.    Rectangles do not scale.
When you select this option, the cursor will turn into a cross.    Move the cross to the area of your
layout that you want to place the beginning of the line at and single-click the left mouse button 
and hold it down. While holding down the mouse button, move the cursor to where you want the 
end of the line to be and release the mouse button. If you want to edit the line, you can double-
click on the line. You can also move lines to a different location by "dragging" it around your 
layout.    See "moving objects" for more information on this.    Note:    As with all objects, the 
Line Objects will "snap" into place on the layout grid.    Please read the layout grid topic for 
more information.
Important Note: lines (rectangles included), do not use fonts. When you print your layout, you 
may need to increase or decrease the size of your object to obtain the desired results.    For 
example, if you draw a box around your name, depending on what font your name is printed in, 
you may need to increase or decrease the width of the box to print it out properly so that it 
surrounds your name.    Open example envelope "SAMPLE3.ENV" for examples of this.    It 
does not matter if the lines look different on your screen then when you print them, what matters 
is that you get the line to print on your printer how you want it to.    Printing your test layouts on 
blank paper will help you make these type of layout adjustments. While we attempted to make 
your layout on the screen look like the one that will be printed, lines are just a different type of 
graphic image that sometimes require adjustments.    Of course, this all depends on what you are 
trying to do with your lines.    If you work with your line objects, you can make them do anything
you want.

See Also

Editing Objects
Layout Grid
Moving Objects
Rectangle Objects



Rectangle Objects 
Use this option to add Rectangle Objects to your layouts.    You can select this feature by using 
the layout menu or by selecting the picture button (shown above) from the tool button bar.    
Note: Rectangles are not scaled to fit larger envelopes.    If you want to draw a rectangle that will 
scale, use four Line Objects to draw the rectangle. Also, rectangles are drawn in the color red so 
that you can tell which boxes were created with a rectangle and which boxes were created with 
lines.
When you select this option, the cursor will turn into a cross.    Move the cross to the area of your
layout that you want to place the upper-left    corner of the rectangle at and single-click the left 
mouse button and hold it down. While holding down the mouse button, move the cursor to where
you want the bottom-right corner of the rectangle to be and release the mouse button. If you want
to edit the rectangle, you can double-click on it. You can also move rectangles to a different 
location by "dragging" it around your layout. See "moving objects" for more information on this. 
Note:    As with all objects, the Rectangle Objects will "snap" into place on the layout grid.    
Please read the layout grid topic for more information.

See Also

Editing Objects
Layout Grid
Line Objects
Moving Objects



Layout Refresh
This option will clear the layout and redraw it on your screen.    This is      useful when you move 
objects such as large fonts that leave a small piece of the object in the old location.    Refreshing 
the screen will get rid of these types of screen clutter.    It is a good idea to refresh your layout 
periodically to get rid of items left behind as screen clutter.    The program will automatically 
refresh your screen when you move and edit most objects. When you need to do it manually, this 
feature is provided.

See Also

Change All Fonts
Clear Contents



Layout Clear Contents
This option will delete all objects from your layout file.    If you want      to get rid of all the 
objects in a layout file and start from scratch, this is the option to use.    To remove only a single 
object from your layout, double-click the left mouse button on the object and choose the delete 
button.

See Also

Change All Fonts
Layout Refresh



Layout Change All Fonts
This feature allows you to change all text fonts on your layout at once. First, you must select the 
font you want to change to.    Next you will be asked to confirm the change with the new font.    
If you select yes, all Text Objects will be changes to the newly selected font.    If you want to 
change the font for only a single Text Object, double-click the left mouse button on the Text 
Object you want to change and then select the font button.

See Also

Layout Clear Contents
Layout Refresh



Tools Menu
The tool menu allows you to interface with other Windows programs to enhance your layout 
options Menu options are as follows:

Paste Clipboard Text
Load Paintbrush
Load Cardfile
Address Book



Paste Clipboard Text
This utility allows you to paste the contents of the Windows Clipboard into your layouts.    You 
may only paste Text Objects.    Add graphic images to your layouts by using the Layout:Picture 
menu option.    You can use any application to copy text into the Clipboard and this program can 
add that text to your layouts.    For best results, we suggest using our Address Book to store your 
addresses, as it can save you a great deal of time when printing envelopes.

All lines in the clipboard will be pasted according to the placement specified in the "Paste 
Options" feature on the Options Menu. By using the Windows Cardfile or preferably, our 
Address Book, you can copy addresses/text to the Windows Clipboard and then paste them into 
your layouts. If you use our Address Book, you can print envelopes by selecting addresses 
without pasting.    This enables you to print envelopes as fast as your printer will allow.    If you 
use an envelope feed tray, the Address Book is what you want to use for larger printing jobs.    
We feature support for Cardfile so customers who already store their addresses in Cardfile can 
use this program, however, we reccomend using our Address Book as it is much more efficient.

Each text line in the clipboard is added to your layout as a Text Object. You can move, modify 
and delete these objects just as you would a regular Text Object.    All objects are added using the
default font.    If you are not familiar with Clipboard, load the Windows Clipboard and read it's 
online help.    Unless you have moved the Clipboard icon, it should be located in your "Main" 
Program Group.    You really don't have to know anything about    Clipboard to use the paste 
feature.    All you really need to know is that    whenever you cut text any application, it is stored 
in the Clipboard for use by other programs, such as this one.    Our Address Book can also copy 
addresses to the Windows Clipboard. Our Financial Freedom Billing Manager can also copy 
customer addresses to the Clipboard. See Designer Envelopes' Help Menu (Other Products 
Option) for more about Billing Manager.

See Also

Address Book
Load Cardfile
Paste Options



Load Paintbrush 
This option will load and run the Windows Paintbrush program.    Paintbrush is a utility that 
comes with Microsoft Windows.    You can create and edit image files with Paintbrush.    The 
images you create can be used by your envelope program to place pictures in your layouts. Read 
the Paintbrush online help for information about creating image files.    You can load paintbrush 
by using the Tools Menu or by clicking on the paintbrush picture button (shown above) located 
on the picture button toolbar.



Load Cardfile 
This option will load and run the Windows Cardfile program.    Cardfile is a utility that comes 
with Microsoft Windows.    You can create and edit text files with Cardfile.    The files you create 
can be used by your envelope program to place addresses in your layouts. Read the Cardfile 
online help for information about creating these address/text files.    You can load Cardfile by 
using the Tools Menu or by clicking on the Cardfile picture button (shown above) located on the 
picture button toolbar.
See Also

Paste Clipboard Text



Options Menu
The options menu allows you to specify how you like your system to interface with you while 
designing your layouts. Menu options are:

Control Panel
Paste Options
Backup Files



Layout Grid    (Options Control Panel)
This option allows you to specify if you want the layout grid drawn on    your screen. If this item 
is checked, it means it is turned on. NOTE: If      you turn the layout grid off, your objects will 
still snap to the grid when you move or place them.    The layout grid is only a visual reference.

See Also

Layout Grid



Options Sizing Grid
This option allows you to specify if you want the sizing grid drawn on    your screen. If this item 
is checked, it means it is turned on. NOTE: If      you turn the sizing grid off, your objects will 
still be scaled for larger envelopes.    The sizing grid is only a visual reference.    You can also use
sizing markers in place of the sizing grid.

See Also

Sizing Markers



Sizing Markers    (Options Control Panel)
This option allows you to specify if you want the sizing markers drawn on    your screen. If this 
item is checked, it means it is turned on.    The sizing markers are placed on the outside edges of 
the design window to represent the sizing grid, however, it does not draw across your screen. The
sizing markers are only a visual reference.    If you turn them off, your layouts will still be scaled 
for larger envelopes.

See Also

Sizing Grid



Other Options    (Options Control Panel)
Sound

This option allows you to specify if you want the program to sound the system beep sound when 
an error, warning or other important message is displayed.    If you turn the sound off, you will 
still receive a visual message.    This option allows you more flexibility for setting up your 
system preferences.

Confirm Deletions

If this option is turned on, the system will ask you to confirm the deletion of an object (line, 
rectangle, picture or text), before it is removed from your layout.    If this option is turned off, 
objects will be deleted as soon as you press the DELETE button.    Turning this feature off allows
you to create and modify layouts much quicker by not having to confirm every object deletion.



Options File Backup
Use the backup utility to periodically backup your data files to a floppy disk.    In the event of 
hardware failure, having a backup will allow you to restore your system to the way it was on 
your last backup date.    We strongly encourage you to backup your files!    It only takes a couple 
of minutes and can save you hours of aggravation.    WARNING:    We will not be able to help 
you restore your system if you do not maintain a backup disk!    If you have a backup disk, we 
will always be glad to help you restore your files after a hardware failure.    NOTE:    Only your 
data files are backed up, not the program files.    Always keep your program diskette in a safe 
place with your backup disk.    You will probably need both disks if you experience hardware 
failure.

When you backup for the first time, you should insert an empty, FORMATTED disk and then 
select the drive A or B.    Select the OK button and the backup will begin.    The program will 
notify you when the backup is complete. Then place the disk in a safe place.    The next time you 
backup, you can use the same disk.    The old backup files will be replaced with the new backup 
files.      

In the event that you ever need to restore your system from your backup files, simply copy all the
files from the backup disk into the directory where your Designer Envelopes program is.    The 
next time you start the system, your system will be exactly how it was when you did your last 
backup.



Help Menu
The help menu allows you to review the online help and to display the Copyright and Trademark 
notices along with information on how to reach M & R Technologies.    Menu options are:

Contents
About



Help Contents
This menu option allows you to load the envelope help file.    You can read about all of the 
programs features by reviewing this file.



Help About
This menu option displays the Copyright and Trademark notices as well as information on how 
to contact M & R Technologies.



Sizing Grid    (Options Control Panel)
The sizing grid is a very important part of designing your layouts. It provides you with a visual 
representation of what objects will be moved to fit nicely on your selected envelope size.    The 
layout window is not adjusted when you change envelope sizes.    The program was designed so 
that you can see your entire envelope without using scroll bars and the like to make an otherwise 
simple task more complicated.    Above all, we have designed our system to be easy to use!    No 
matter which size you select, you will always see the entire layout on your screen. NOTE: the 
sizing grid is not used when creating letterhead Stationery layouts.

You have two options of displaying the sizing grid, both of which are located on the options 
menu.    You can display the entire sizing grid across your screen and/or you can display sizing 
markers on the inside edges of the design window.    We recommend you use one or both of these
options so that you can tell what objects will be moved, however, you may turn them off if you 
prefer.    After you finalize your layout, you may choose to keep them turned off since you will 
probably only be changing the "send to" address part of your layout.

The sizing grid displays plus (++) signs to indicate the grid lines. There are two horizontal and 
two vertical grid lines.    Lets take the horizontal (side to side) grids first.    These two grids 
effectively divide your screen into three areas, top, middle and bottom. An object is determined 
to reside in the grid by it's upper left-hand screen location.    The horizontal grid scales objects 
from top to bottom of the envelope.    Objects in the top grid are not moved down. Objects in the 
middle grid are moved down to the center area of the envelope. Objects in the bottom grid are 
moved down to the bottom of the envelope. The amount each object is moved is determined by 
what envelope size you have currently selected when you print out your layout design.

The vertical grids (top of screen to bottom) work exactly as the horizontal grids, however, they 
scale items from left to right. Objects which reside in the left grid are not moved right.    Items 
which reside in the center grid are moved right to the middle of the envelope and objects in the 
right-most grid are moved the farthest to the right side of the envelope.

The idea behind the grids is really quite simple and allows the program to scale any layout to fit 
on the selected envelope size.    Again, an object is determined to be placed in a grid by it's 
upper-left hand position on the screen.    For example, if you have a Text Object on your screen 
which says "Have a nice day!", the grid that this text is located in is determined by the "H" (the 
first character of the Text Object). It does not matter if the "nice day!" part is located in the next 
grid. The upper-left hand corner of the object determine which grid the object resides in.    The 
best way to tell what will happen is to make a layout and print it on a blank sheet of paper.    If it 
looks spaced correctly on the paper, print it on an envelope.    After you create one layout, you 
will have the idea behind the grid lines down.    Take a look at the sample layout files we have 
included.    You can save them to different files and just change the text if you'd like, but they 
give you some good ideas about what kind of layouts you can design. Play around with different 
objects and placements to get a complete understanding.    You will become a design expert in no 
time!

See Also

Layout Grid



Letterhead Stationery
Sizing Markers
Size Selection



Moving Objects
To move any object, single-click the left mouse button on the object that you want to move, 
making sure not to release the mouse button. A rectangle will appear around the object.    While 
holding down the mouse button, move the mouse to the new location and release the mouse 
button.    By using this "point and click" method, moving objects is very easy!

When you release the mouse button, the object will be redrawn at the new location.    All objects 
will "snap into place" on the layout grid. See the layout grid topic for more information.

See Also

Editing Objects
Layout Grid
Line Objects
Picture Objects
Rectangle Objects
Text Object



Editing Objects
To edit any object, double-click the left mouse button on the object that you want to edit.    
Depending on what type of object you selected, an editing window will appear.    This window 
will allow you to change the object or delete it.

Text Object:    When editing a Text Object, you can change the text, the font or delete the object.  
The current font name, size and style will appear in the editing window.

Picture Object:    When editing a Picture Object, you can change it to a different picture, edit the 
existing picture or delete it.    All pictures are stored in Windows bitmap formats (*.BMP), 
allowing you to create and edit pictures using Windows Paintbrush.    You can launch paintbrush 
by using the TOOLS menu or by clicking on the paintbrush picture button.

Line Object:    When editing a line, you can change the length of the line or delete it.    NOTE: 
Lines are always printed on your printer last.    Therefore, if a line looks "covered up" on your 
screen by the white-space around a picture, it will not be covered when it is printed.    

Rectangle Object:    When editing rectangles, you can change the height, width or delete the 
object.    Rectangles are printed on your printer after Picture Objects.    See the note above about 
white-space.    

See Also

Layout Grid
Line Objects
Moving Objects
Picture Objects
Rectangle Objects
Text Object



Layout Grid
The layout grid is used to place the objects on your layout.    This program does not work on a 
pixel by pixel layout, instead, it was designed to work on logical units that represent a height and
width of most envelopes while maintaining an aspect ratio which will work on all printers.    The 
logical units for the design window (for VGA monitors) is 77 units wide and 22 units for the 
height. What this means to you is that you can move objects across your screen in 77 different 
places (right/left) and you have 22 different places (up/down) that you can move objects.    A 77 
by 22 logical unit layout is really more than is needed for creating envelope layouts, but we 
wanted to provide you with the best possible aspect ratio while taking into consideration the 
many different printers in use today. Furthermore, an envelope should not appear "cluttered" 
when you print it. The people at the Post Office want to be able to glance at your envelope to 
direct it to it's proper destination.    Additionally, if you use a large font, you should space the 
Text Objects further apart than if you were using a smaller font.    All of this is a rather 
"practical" and "logical" way of providing you with a powerful and fast designing tool.    NOTE: 
when creating letterhead Stationery, you actually have about 60-70 units up/down, for placing 
vertical lines, depending on your printer. You won't be able to see all 60-70 units until you print 
your layout, as only the top 22 units are displayed on your screen.    Just be aware that you can 
draw a line down the entire left side of the letterhead if you choose to do so.

When you place an object in your layout, it will "snap" to the closest logical unit location and 
plant itself there.    When you use large fonts or pictures, obviously, they will occupy more than 
one logical unit. Unless you move a large Text Object or picture away from another object, they 
may overlap each other, creating screen clutter.    Also remember that you will be printing out the 
objects and you should not make text objects touch each other.    It is very important that you try 
to leave as much "white space" on your envelope as you can to produce a professional, 
uncluttered appearance.    

The more fancy you want to make your envelopes, the harder you will have to work to create 
your layout. This usually means creating layouts, printing them, editing layouts, printing them, 
etc. until you achieve your desired results.    Of course, we encourage you to create nice layouts 
and we know our program can handle them.    When you register this product, if you have a 
layout you are proud of, please use it to print the envelope when you send us your registration.    
We are always interested in what's being done with our products.

See Also
Letterhead Stationery
Sizing Grid



Default Font
The default font is used to place new Text Objects on your screen. You can change the current 
default font a couple of ways.    When you double-click your mouse on a Text Object and change 
the font, the new font becomes your default font.    This is useful when you start a new layout.    
Place your first text line, double-click on it and change the font to your preference. This is now 
your default font.    All other new Text Objects will now use this font when you add them.    The 
other way to change the default font is when you use the "change all fonts" option on the layout 
menu to change all the fonts.    You can always tell what font a Text Object is using by double-
clicking the mouse on a Text Object.    The font name, size and style are displayed at the top of 
the edit window.

See Also

Text Editor 





Text Editor
The text editor allows you to change or delete a current Text Object. When you double-click the 
left mouse button on a Text Object, the text editor will appear. You can change the text, change 
the font or delete it.    The current font, size and style are always shown in the top of the text 
editor.    When you select the fonts option, it is assumed that you are changing the font and 
therefore the font selection box is not updated to reflect the current font.    Select a new font, or 
choose the cancel button to close the window.

When you change the font, it becomes your default font.    All new text objects added to your 
layout will use the current default font.    Use the text editor to manage all of your Text Objects.

See Also

Default Font 
Editing Objects
Picture Editor 



Picture Editor
The picture/image editor allows you to change or delete a current picture object. When you 
double-click the left mouse button on a Picture Object, the picture editor will appear. You can 
change the picture, edit or delete it.    Use the picture editor to manage all of your Picture 
Objects.    You can create your own pictures by using Windows Paintbrush.    Also, you may use 
any pictures in bitmap format, such as the ones created with Paintbrush.    The envelope program 
does not need the bitmap to be stored with the program files.    It can use any bitmap no matter 
where it is on your computer. It will remember the disk and directory you selected the image 
from and will always look there when it needs to find the image file.    This will save hard disk 
space by not having a copy of the image in two directories.

See Also

Editing Objects
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Text Editor 



Letterhead Stationery
You can create letterhead Stationery with Designer Envelopes.    This allows you to create 
envelopes and Stationery that match each other!    If you run a company or just want to create a 
"polished" look for yourself, this feature is just what you need. While all envelope layout files 
carry a file extension of *.ENV, letterhead layouts carry a file extension of *.LHD. If you have 
created an envelope layout file and want to save it as a letterhead layout, use the File:Save As 
menu option and save it to a file name ending with .LHD, then make any changes specific to 
your letterhead.(i.e. your envelope layout might say "First Class Mail" but you would not want 
this in your letterhead layout). The whole idea is to make your envelope layout match your 
letterhead layout, but they differ from each other in the manner each is used. Make your 
envelope look like an envelope, and your letterhead look like a letterhead, but retain any 
similarities, such as lines and pictures.

When you use the File:Open menu option, you will notice a box at the bottom of the dialog box 
entitled "List Files of Type". Click on the arrow on the right side of the box and the list will drop 
down.    Select which file type you want displayed.    The files matching this file type will be 
displayed. You can switch back and forth between file types by using this box.

When designing a letterhead layout, you will only see the top of the letterhead layout, i.e., you 
can't place a line across the bottom of your design.    That would not be appropriate for letterhead
Stationery. However, if you want to draw a line on the left side from the top of the page to the 
bottom of the page, this would be appropriate. To do this you would add a vertical line on the left
side, then double click on it to change it's length. Depending on your printer, you would make it 
between 60 and 68 logical units long.    You will have to print it out and adjust the line length 
accordingly.    See SAMPLE1.LHD for an example of this.    Also, the sizing grids are not used 
with letterhead layouts as they are not needed, however, the layout grid is used to place objects 
on your letterhead.

Once your letterhead design is finalized, you will want to print several copies for later use.    You 
should be in portrait mode when you print your layout.    Then when you write a letter with your 
word processor, set the margins so that your memo will fit on your new letterhead Stationery. 
Depending on what type of letterhead you have created, you may have to adjust the margins and 
print a test copy before you get it exactly the way you want.    Before you print out your memo, 
be sure to place your new letterhead Stationery in your printer first.    Your memo will then print 
on top of your Stationery, creating a very nice document. If you really want to experiment, try 
using different colored paper when printing out your letterhead.    Between envelopes and 
letterheads, you can really create a spectacular image for yourself or your company.

See Also
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Control Panel
The Control Panel controls the following features:

Layout Grid
Sizing Grid
Sizing Markers
Alert Boxes
Other Options
Startup/Exit Modes



Alert Boxes    (Options Control Panel)
When you print envelopes, you do so in either landscape or portrait mode, depending on your 
type of printer.    The alert boxes allow you to make sure you are in the right mode before your 
layout is printed.    For example, if you print envelopes in landscape mode, set the alert box to 
notify you when you try to print an envelope in portrait mode.    If you try to print your layout in 
portrait mode, a box will appear telling you that you are in portrait mode and ask you if you want
to continue. 

See Also

Mode Setup



Startup/Exit Mode Configuration    (Options Control Panel)
When you print envelopes, you do so in either landscape or portrait mode, depending on your 
type of printer.    This feature allows you to setup the starting and exiting mode for your system.   
For example, if you want the system to always be in landscape mode each time you start 
Designer Envelopes and/or portrait mode each time you exit, this is the feature to use. This 
feature was added to eliminate conflicts with other Windows software that utilize the portrait and
landscape mode settings. This feature insures that you will always start the system in your 
preferred printing mode. 

See Also

Alert Boxes



Address Book
The Address Book allows you to enter addresses or other information into Designer Envelopes' 
Database.    To edit any field, simply click on it and then edit/enter the information in that field. 
You actually do your editing right in the fields that appear in the Address Book Window. Please 
note that if you need to print labels, Financial Freedom Cards & Labels can read your Designer 
Envelopes Database. Contact M & R Technologies for more information about our Cards & 
Labels program. Also note that the Address Book Database has five fields for each record. 
Generally, you would enter addresses into these fields, however, you may enter any information 
you require. The records in the Address Book are automatically sorted by the data entered into 
FIELD1.    If you make adjustments to field1 so that it would cause the record to be out of place, 
it will be moved for you by the program.

While viewing the Address Book, you have several options available to you via the buttons on 
the bottom of your screen. When you select the "Print Envelope" button, the currently selected 
(highlighted) record will be printed, using the currently opened layout file. This allows you to 
print envelopes as fast as your printer can print them! Please note that the address will be printed 
on your envelope at the location specified in the "Paste Options" feature on the Options Menu. If 
you use an envelope feeder tray, this is the option for you!

You can add records to your Address Book by selecting the "Add Record" button. This will add a
blank record in the database which allows you to then enter your information into one (or all) of 
the five fields for that record. Use the scroll bars to move around in the address book and click 
the mouse on any fields you want to edit. When you select the "Delete Record" button, the 
currently highlighted (selected) record will be marked as deleted. You can tell if a record is 
deleted by looking at the status bar on the bottom of your record list.    Deleted records are not 
removed until you exit from the Address Book.

Use the "Top of File" and "Bottom of File" buttons to go to the first or last records in the address 
book. You can also copy the current record to the clipboard by selecting the "Copy to Clipboard" 
button.    This allows you to paste the record into your layout, or to paste the information into any
other program you use that can read from Windows Clipboard. For example, you may want to 
paste a record into your word processing document.

The advantage of using the Address Book over the Windows Cardfile interface is the fact that 
you can print envelopes while viewing your Address Book. Additionally, any program that can 
read dbase-compatible files can also read your address book, as all information is stored in a 
standard dbase file format. The name of your address book database file is FFDEDATA.DBF.

See Also
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Paste Options
This feature allows you to specify where the pasted text will be placed on your layout when you 
use the "Paste Clipboard Text" feature located on the Tools Menu. You specify the ROW and 
COLUMN. Rows are counted from top to bottom and columns are counted from left to right. It 
is sometimes helpful for you to turn on the Layout Grid, so you can "see" your rows and 
columns. The spacing between text lines allows you to set the distance, (in rows) of the space 
between pasted text objects. Please note that by using this feature, you can paste data anywhere 
on your layout.

HINT: The text is pasted into your layout using the current default font.    If after you have pasted
text, you want to change the font of the pasted text, double-click on one of the pasted text lines 
and change the font.    The font you select is now your default font. Now re-paste your text. The 
old text will be removed and pasted back into the layout using the new default font.

The checkbox "Clear previous paste when pasting new" is used to    clear off previously pasted 
text, when new text is pasted into the layout.    If this option is turned off, previously pasted text 
will not be removed.    When this option is turned on, only text that has been PASTED is 
removed.    Any text objects that have been PLACED on the layout are not removed. As you can 
see, pasted text objects and regular text objects are handled slightly different. Pasted text objects 
can only be added to a layout by using the "Paste Clipboard text" option, while regular text 
objects are placed using the Layout Menu or Picture Button on the Toolbar. To make pasted text 
easy to identify, it is drawn on your layout with a green background.

PLEASE NOTE: The first row and column is always zero (0). When counting your rows and 
columns, start the count with 0. What this means is that if you enter a row value of 10, the first 
text line will actually be placed on row 11 of the Layout Grid. Likewise, if you enter a column 
value of 40, column 41 will be used. If you wanted to paste the text in the upper left-hand corner,
you would enter a column value of 0 and row value of 0.

See Also
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Printer Resolution
For each printer that you use, you should have a driver installed under Windows to tell it how 
you want your printed output. You can access this information by using the Windows Control 
Panel and selecting the "Printers" icon option. A list of installed print drivers will be displayed, 
allowing you to change and/or setup any information specific to that printer. One of the options 
available is the print resolution, which can usually be found via the "Setup" button.    Consult 
your Windows or printer manual for further information on setting up your print resolution.

The print resolution setting is a very important part of your printer configuration.    For example, 
if you setup your printer driver to print 300 DPI (dots per inch) instead of 150 DPI, your output 
will look much nicer because 300 dots per inch are printed instead of 150. However, on most 
laser printers, you won't notice the difference unless you look very closely!    Printing 300 DPI 
instead of a lesser amount, requires much more free disk space and more memory.    Memory or 
disk space you may not have.    If you use a lower print resolution, you can print envelopes much 
faster, because less memory and disk space is required to "draw" your layout. Also, at 300 DPI it 
takes about twice as long to print your envelopes because Windows Print Manager is printing at a
much higher resolution.    For a good example of the difference between 150 DPI and 300 DPI, 
print out "STARTUP.ENV" on plain paper using both settings. Note the difference between each 
printed layout, such as the shaded areas. Also note that only the pictures are effected and not the 
text. Therefore, printing at a lesser DPI should be fine, unless you add shaded pictures to your 
layouts.

All of these settings are up to you.    Be aware, that this program can use a high resolution to print
your envelopes, if you have the hardware to support it.    This is an issue between your hardware 
and Windows. If your printed output appears poor, increase your print resolution. If you have 
plenty of hard disk space and/or memory, this will probably not be an issue to you. If you receive
an "out of memory" error, you'll want to consider this information. 



A Text Object is an object containing a line of text such as "How are you" or "Have a nice day".   
You can move, edit or delete any object.    Text Objects are the way you add text to your layouts.



A Picture Object is an object containing a picture image.    You can move, edit or delete any 
object.    Picture Objects are the way you add pictures to your layouts.    All picture files must be 
in bitmap format and can reside in any directory on your computer.



A Line Object is an object containing a straight line.    You can move, edit or delete any object.    
Line Objects are the way you draw lines on your layouts.    All Line Objects are scaled to fit 
different envelope sizes, while rectangles are not.    Also, lines do not use fonts, so they may need
to be increased or decreased in size to obtain your end result. 



A Rectangle Object is an object containing a four-sided box.    You can move, edit or delete any 
object.    Rectangle Objects are the way you draw boxes    on your layouts.    Rectangle Objects 
are NOT scaled to fit different envelope sizes.    If you want the box to scale, make a box with 
four Line Objects. Rectangle Objects are drawn using the color red so that you can tell a 
Rectangle Object from a box made with four Line Objects. See SAMPLE3.ENV for examples of 
rectangles and boxes made with four lines. Print it on different size envelopes to see the 
difference between lines and rectangles. 






